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Section 1 
 Getting to Know Your Camera

Overview

Thank you for purchasing this camera. Everything you need to take quality digital photos and videos is 
included with your camera.

Vivitar makes capturing those special moments as easy as possible.

The camera with 5 Mega Pixel sensor can take H.264 movies. By way of using H.264 technology, more 
videos can be taken within certain amount of memory. High quality images with up to 16 mega-pixels 
can also be delivered smoothly. With a color LCD monitor, users can compose images and examine 
them easily. 

The camera features 3” LCD touch panel which is an ideal platform for you to operate your camera. The 
menu options are accessible with your finger. With the touch panel, you can select the options directly 
and quickly.  

The camera also features movie recording at an HD resolution of 1920x1080. You can also connect it 
to an HDTV via an HDMI cable, and easily playback the recorded high-definition videos on the wide 
screen HDTV. 

Moreover, the camera has an advanced uploading feature. With the exclusive built-in Internet Direct 
application, you can upload the videos captured by the camera to Internet more effortlessly.

ISO sensitivity and color balance can either be adjusted automatically or changed manually. A 4x digital 
zoom helps you to control over the movies and pictures you take. 

The varied effect options, such as Time Lapse and Slow Motion, make recording more fun.

The built-in memory allows you to take pictures and to record movies without a memory card. The 
memory card slot allows users to increase the storage capacity. 

 Note
Partial memory of the built-in memory is used for the camera’s Firmware code.

Standard Accessories

Unpack the package and make sure all standard accessories listed are included:

• Camera

• USB Cable

• AV Cable

• HDMI Cable

• Adaptor

• Lithium-ion Rechargeable Battery

• Quick Guide

• CD-ROM (Software and User’s Manual)

• Cloth Bag

• Lens Cover Set (Lens cover and Strap)
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Section 2 
 Getting Started

Loading the Battery

Before using the camera, users must load the Lithium-ion 
rechargeable battery come within the package. 

1. Slide the safety latch to the unlocked position and open 
the battery cover.

2.  Insert the battery according to the correct polarity marks 
( + or -).

3. Close the battery cover firmly, and slide the safety latch 
to the locked position.

Inserting and Removing an SD Card (Optional)

The camera comes with an internal memory which allows 
you to store pictures and movies. You can expand the 
memory capacity by using an optional SD/SDHC memory 
card. 

1. Insert the memory card into the slot. Please refer to the 
figure on the right side.

2. To remove an installed SD card, press the card inwards 
to release it.

3. When the card pops out, gently remove it from its slot.

4. Recommended memory capacity: 1GB or above.

 Note
• When a memory card is fitted, movies/pictures are saved on the card rather than on the built-in 

memory.

•	 Protecting Data on an SD Card: SD Card is read-
only when it is locked. No pictures or movies can be 
recorded when the SD card is locked. Make sure the 
lock is on the writeable position before recording any 
media. Writeable 

position
Write-Protected 

Position
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Turning the Camera On and Getting Started

• To turn on the camera: 

1. Flip out the LCD panel; the camera will turn on automatically.

2. Or press Power Button for one second to turn it on.

• To record movies: Press Mode Button or touch  on the screen to switch to the Movie Record 
mode .(The Movie Mode LED Indicator  will light up.) Press OK Button to record movies. 

• To take a picture: Press Mode Button or touch  on the screen to switch to the Picture Record 
mode. (The Picture Mode LED Indicator  will light up.) Press OK Button halfway down until the 
focusing frame turns from white to green. Then, press it fully down to take pictures.

  

Focusing Frame: White Focusing Frame: Green 

• To take a picture during movie recording: When recording movies, press Mode Button ( ) to capture 
the image. The Dual record icon(  ) appears on the LCD monitor.

• To view stored movies and pictures: Press Playback Button or press  on the screen to switch 
to the Playback mode. (The Playback LED Indicator  will light up.) Press Mode Button or touch 

 on the screen to switch between Movie Preview Screen and Picture Preview Screen.

Turning the Camera Off

• To turn off the camera: You can either press the Power Button for one second, or you can place the 
LCD panel back to its original position.



8
EN

Section 3 
Enjoying the Record Mode

Button Function

Rolling Wheel: Rotate to move between the wheel menu 
options. 

Right Button: LCD Information ON/OFF. In Record menu, 
press to switch to the submenu.

Left Button: Flash Auto/Red-Eye-Reduction/Digital Light/
Flash OFF. In Record menu, press to return to the main 
menu.

Up Button: Move between the option items.

Down Button: Delete the current or all movies/pictures. 
Move between the option items.

OK Button: 

1. Validate the setting.

2. In Movie Record Mode, press to take movies. To stop 
recording, press it again.

3. In Picture Record Mode, press to take pictures.

Tele Button : Zoom In

Wide Button : Zoom out

Playback Button: 

1. Switch between Record / Playback Mode.

2. For quick review, press it after recording.

3. In Record menu, press to exit.

Mode Button: 

1. Switch between Movie Mode and Picture Mode.

2. When recording movies, press to capture the image. 

Power Button: Press down for one second to turn on or turn 
off the camera.

Pre-Record/Internet Button:In Record Mode, press

to activate the function that the movies are recorded 3 seconds 
before the OK Button is pressed.
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LCD Monitor Information

The indicators shown below may display on LCD when movies and pictures are recorded:

(1)

Movie Resolution

FHD (1080p 30)

HD (720p 30)

WVGA 60

VGA (4:3)

Slow Motion (Record movies at 320x240 resolution.)

Picture Resolution 

High (16 MP)

Standard (5 MP)

Low (3 MP)

(2)

Recording time of the movie that can still be taken at current 
resolution

Number of images that can still be taken at current resolution

(3)
Self-timer enabled

Dual Record

(4) Stabilization

(5)
Pre-Record Mode

Time Lapse
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(6)

Scene

Skin

Night

Backlight

(7) Macro Position Focusing

(8) Manual White Balance

(9) Motion Detection

(10)

Zoom meter:
FHD (1080p 30):1X~10X (10X Optical zoom and 1X Digital zoom)
Other video resolution:1X~40X (10X Optical zoom and 4X Digital 
zoom)

(11) Option Menu

(12) Playback Mode

(13) Movie/Picture Record Mode

(14)

Movie Mode

Digital Light On

Picture Mode

Flash Auto

Red Eye Reduction

Digital Light On

Flash Off

(15) SD Card Inserted

(16)

Battery: full power

Battery: medium power

Battery: low power

Battery: empty power

DC power mode

 Note
Scene: B/W / Classic / Negative effect can be previewed immediately without indicator on the 
LCD.
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Movie Recording

• In Movie Record Mode (The Movie Record LED Indicator  lights up), press OK Button to start 
recording. When a movie is being recorded, a time indicator will display on the LCD monitor. To stop 
recording, press OK Button again. 

• Optional function

1. Dual record: press Mode Button ( ) to capture the image. The Dual record icon(  ) appears 
on the LCD monitor.

• Press Playback Button to view the recorded movies.

• Four resolution settings are available: 

Video Quality

FHD (1080p 30)

HD (720p 30)

WVGA 60

VGA (4:3)

 Note
•	 The image resolution captured during movies recording is the same as the video resolution.
•	 The	flash	can	not	be	used	when	capturing	image	during	movies	recording.

Using the Pre-Record Function

• The Pre-record function ensures that you will not miss any critical recording opportunities, The movies 
are recorded 3 seconds before the OK Button is pressed.

• To use the Pre-Record function:

1. Press the Pre-Record Button ( ) in Record Mode. The Pre-Record icon(  ) appears on the 
LCD monitor.

2. Aim the camera at the subject and position it securely.

3. Press the OK Button to start recording. (The camera records 3 seconds before you actually press 
the OK Button.) 

• To use the function again, set it again.

 Note
•	 Time Lapse function can not be used when the Pre-Record function is activated.
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Picture Recording

• In Picture Record Mode (The Picture Record LED Indicator  lights up), press OK Button  halfway 
down until the focusing frame turns from white to green. Then, press it fully down to take a picture.

• Press Playback Button to view the picture.

• Three resolution settings are available: 

Image Quality 

High Quality:16 Mega Pixels 

Standard Quality:5 Mega Pixels

Low Quality:3 Mega Pixels

Using Flash or Digital Light Function

• This camera has three flash settings and one setting to allow you to extend the brightness of the 
objects that are dark or in the shadow. Using Left Button to change the settings.

1. Flash Auto (  ): The flash fires automatically according to light conditions. Use this mode for 
general photography. (Picture Recording Only)

2. Red Eye Reduction(  ): The pre-flash will fire to reduce the red-eye effect. (Picture Recording 
Only)

3. Digital Light ( ): To extend the dynamic range for backlight and high contrast sense so that 
the objects will be brighter and clearer.

4. Flash Off (  ): The flash will not fire under any circumstances. Use this mode when taking 
images in a place where flash photography is prohibited, or when the subject is distant (beyond 
the range of the flash). (Picture Recording Only)

 Note
The	flash	will	be	disabled	automatically	when	the	battery	power	is	low	(  ).

Using Zoom Function

• The zoom magnifies images when recording movies or taking pictures.

1. To zoom in/out, press the Tele/Wide Button.

2. It can be set from 1X~10X (10X Optical zoom and 1X Digital zoom)/1X~40X (10X Optical zoom and 
4X Digital zoom)
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Options for Record Menu
Movie Record Mode Menu

Movie Resolution White Balance Scene Effect

• FHD (1080p 30)
• HD (720p 30)
• WVGA60
• VGA (4:3)

• Auto
• Daylight
• Fluorescent 
• Tungsten

• Auto
• Skin
• Night
• Backlight
• B/W (Black/White)
• Classic
• Negative

• Stabilization
• Macro Mode
• Motion Detect.  

(Motion Detection)
• Slow Motion 
• Time Lapse

Picture Record Mode Menu

Picture Resolution White Balance Scene Effect

• High (16MP)
• Std (5MP)
• Low (3MP)

• Auto
• Daylight
• Fluorescent 
• Tungsten

• Auto
• Skin
• Night
• Backlight
• B/W (Black/White)
• Classic
• Negative

• Self-Timer
• Macro Mode
• ISO

Operations for Record Mode 

Operation Screen

1. Touch (on-screen icon) in Record Mode. The wheel 
menu will show on the screen. 

2. Scroll the wheel menu on the screen lightly with 
your finger to move between the options, which are 
Resolution, Scene, Effect, White Balance, and Setting. 

3. Submenu will pop up while stopping on each option.
4. Touch to select the specific option you want to adjust, 

then touch [OK] to validate the setting. 
5. Or touch the Return icon (  ) to exit without any 

change.
6. Touch /  on the screen to change between the 

pages.
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Movie Resolution

Four resolution settings are available.

• FHD (1080p 30): Record movies at 1920x1080p 30 resolution.
• HD (720p 30): Record movies at 1280x720p 30 resolution.
• WVGA 60: Record movies at 848x480 60 resolution.
• VGA(4:3): Record movies at 640x480p 30 resolution.

Operation Display Screen

1. In Movie Record Mode, touch (on-screen 
icon) to show the wheel menu. 

2. Scroll and stop on [Resolution]. The submenu of 
Resolution pops up.

3. Touch the desired option. 

4. Touch [OK] to validate the setting.
 

Picture Resolution

Three resolution settings are available.

• High (16MP): Shoot pictures at 4608x3456, 16MP quality.
• Std (5MP)(Standard): Shoot pictures at 2592x1944, 5MP quality.
• Low (3MP): Shoot pictures at 2048 x 1536, 3MP quality.

Operation Display Screen

1. In Picture Record Mode, touch (on-screen 
icon) to show the wheel menu. 

2. Scroll and stop on [Resolution]. The submenu of 
Resolution pops up.

3. Touch the desired option. 

4. Touch [OK] to validate the setting. 
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White Balance 

The camera adjusts the color balance of images automatically. Three manual white balance settings are 
available:

• Auto: The camera automatically adjusts white balance.

• Daylight: Under outdoor condition.

• Fluorescent: Under fluorescent light condition.

• Tungsten: Under tungsten light condition.

Operation Display Screen

1. In Movie/Picture Record Mode, touch (on-
screen icon) to show the wheel menu. 

2. Scroll and stop on [White Balance]. The submenu 
of White Balance pops up.

3. Touch the desired option. 

4. Touch [OK] to validate the setting.

Scene 

You can select the mode according to the scene condition.

• Auto: Shoot without any special effect on the image.

• Skin: Shoot with an effect that makes skin tones more natural. 

• Night: Use Night Mode for night scenes or low light conditions.

• Backlight: You can take shots when the bright light is behind the subject.

• B/W (Black/White): The image is converted to black-and-white.

• Classic: The image is converted to a sepia look.

• Negative: The image is converted as the negative of the normal

Operation Display Screen

1. In Movie/Picture Record Mode, touch (on-
screen icon) to show the wheel menu. 

2. Scroll and stop on [Scene]. The submenu of 
Scene pops up.

3. Touch the desired option. 

4. Touch [OK] to validate the setting.

 Note
To	avoid	blurry	pictures,	place	the	camera	on	a	flat,	steady	surface,	or	use	a	tripod	when	taking	
shots in the Night Mode.
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Movie Effect

Operation Display Screen

1. In Movie Record Mode, touch (on-screen 
icon) to show the wheel menu. 

2. Scroll and stop on [Effect]. The submenu of 
Effect pops up.

3. Touch the desired Effect option to enter its option 
screen.

4. The Movie Effect submenu contains 5 options-- 
Stabilization, Macro Mode, Motion Detection, 
Slow Motion, and Time Lapse --for you to adjust 
the camera’s settings.

Stabilization

Record with an effect of reducing camera shake to result in more stable videos. 

Operation Display Screen

1. In the Effect submenu, touch [Stabilization] to 
enter the option screen.

2. Touch the desired option. 

3. Touch [OK] to validate the setting.

 Note
Stabilization	doesn’t	apply	on	FHD(1080p	30)	and	WVGA60.

 
Macro Mode

• Auto: The camera adjusts the focus automatically. 
• Macro(  ): The camera adjusts the focus with priority on close- up objects. Shoot in Macro mode 

when the objects are located in 1 cm~Infinite (setting to the Wide side)/60 cm~Infinite (setting to the 
Tele side).

Operation Display Screen

1. In the Effect submenu, touch [Macro] to enter 
the option screen.

2. Touch the desired option. 

3. Touch [OK] to validate the setting.
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Motion Detection

Record videos automatically when the camera detects a movement.

Operation Display Screen

1. In the Effect submenu, touch [Motion Detect.] to 
enter the option screen.

2. Touch the desired option. 

3. Touch [OK] to validate the setting.

4. Camera will start to record video automatically if 
it detects a movement. Stop recording if it does 
not detect a movement.

Slow Motion

Record videos with slow motion effect. When the video is played, the playback time will be longer than 
the actual recording time.

Operation Display Screen

1. In the Effect submenu, touch [Slow Motion] to 
enter the option screen.

2. Touch the desired option. 

3. Touch [OK] to validate the setting. 

Time Lapse

Record still images at specific intervals you can set and play them as one movie file.

• Off: Disable Time Lapse.
• 1 Sec.: Record one frame per second.
• 3 Sec.: Record one frame every 3 seconds.
• 5 Sec.: Record one frame every 5 seconds.

Operation Display Screen

1. In the Effect submenu, touch [Time Lapse] to 
enter the option screen.

2. Touch the desired option. 

3. Touch [OK] to validate the setting.

 Note
•	 Stabilization function can not be used when Time Lapse function is activated.
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Picture Effect

Operation Display Screen

1. In Picture Record Mode, touch (on-screen 
icon) to show the wheel menu. 

2. Scroll and stop on [Effect]. The submenu of 
Effect pops up.

3. Touch the desired Effect option to enter its option 
screen. 

4. The Picture Effect submenu contains 3 options 
--Self Timer, Macro Mode, and ISO-- for you to 
adjust the camera’s setting.

Self-Timer

The self-timer allows you to take pictures with a ten-second time delay. The self-timer light on the front

of the camera will also blink. The speed of blinking will increase just before the picture is taken.

Operation Display Screen

1. In the Effect submenu, touch [Self-Timer] to 
enter the option screen.

2. Touch the desired option. 

3. Touch [OK] to validate the setting..

Macro Mode

• Auto: The camera adjusts the focus automatically. 
• Macro(  ): The camera adjusts the focus with priority on close- up objects. Shoot in Macro mode 

when the objects are located in 1 cm~Infinite (setting to the Wide side)/60 cm~Infinite (setting to the 
Tele side).

Operation Display Screen

1. In Effect submenu, touch [Macro Mode] to enter 
the option screen.

2. Touch the desired option. 

3. Touch [OK] to validate the setting. 
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ISO

The camera adjusts the ISO sensitivity of its images automatically. Two manual ISO sensitivity settings 
are available. (800/1600) The larger the number is, the higher the ISO sensitivity is set to. Select a small 
number to shoot a smoother image.  Select a large number to shoot an image in a dark location or to 
shoot a subject moving at high speed.

Operation Display Screen

1. In the Effect submenu, touch [ISO] to enter the 
option screen.

2. Touch the desired option. 

3. Touch [OK] to validate the setting.

 Note
The image may become noisy when the ISO number is large.
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Section 4 
 Enjoying the Playback Mode

Button Function

The Buttons have the following functions in Playback Mode. 

Rolling Wheel: Rotate to move to the previous/next movie/
picture.

Right Button: LCD Information ON/OFF; Fast forward. 

Left Button: Fast rewind. 

Down Button: Delete the current movie/picture or all movies/
pictures.

OK Button: 

1. Enter Movie/Picture Playback Mode.

2. Validate the setting. 

3. In Picture Playback Mode, press to start/stop the 
slideshow.

Tele Button : Zoom In

Wide Button : Zoom out

Mode Button: 

1. Switch between Movie Preview Screen and Picture Preview 
Screen.

Playback Button: 

1. Switch between Record /Playback Mode.

2. Return to the previous screen.

Pre-Record/ Internet Button: In Movie Playback Mode, press 
to select the current movie to upload to Internet.
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LCD Monitor Information

Indicators on the LCD screen while in Playback Mode:

Playback Preview Screen

Movie Playback Mode Picture Playback Mode

(1)

Movie Resolution

FHD(1080p 30)

HD (720p 30)

WVGA 60

VGA (4:3)

Slow Motion (320x240)

Picture Resolution 

High (16 MP)

Standard (5MP)

Low (3MP)

Dual Record (The image resolution captured during movies recording 
is the same as the video resolution.)

(2) 0003/0005 Current number/ Total number of picture/movie.
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(3) Movie/Picture Preview Screen On

(4) Return to the previous screen/ Switch to Record Mode

(5) Movie playback time counter

(6) Delete 

(7) Upload selected movies to Internet

(8) Volume

(9) Previous movie/picture 

(10) Movies fast rewind

(11)
Movies Play

Movies Pause

(12) Movies fast forward

(13) Next movie/picture

(14)
Slideshow

Slideshow stop

(15) Magnification Indicator
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Operations for Playback Mode 

The Playback Mode is for viewing and managing movies and pictures on the built-in memory or on an 
SD Card.

Operation Display Screen

1. Press Playback Button (  ) or press  on the 
screen to switch to the Playback mode.

2. In the Playback preview screen, press Mode Button or 
touch  on the screen to switch between the Movie 
mode and the Picture mode.

3. Sweep to the left to go to the previous picture/movie; 
sweep to the right to go to the next picture/movie. 

4. Touch on the picture/movie to go to Picture/Movie Playback 
Mode.

Movie Playback

Operation Display Screen

1. When in Movie Playback mode, touch /  to play 
or pause the movies.

2. Sweep to the right or touch  to go to the previous 
movie; sweep to the left or touch  to go to the next 
movie. 

3. While playing movies, touch  / to fast rewind/
forward. 

4. Touch to increase the volume; touch  to reduce 
the volume.

5. Touch (  ) to exit.
6. Press Internet Button to select the existing movies to 

upload to Internet.
 Note
When	 the	 LCD	 is	 idle	 for	 a	 few	 seconds,	 the	 playback	 function	 icons	 will	 disappear	
automatically.
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Delete Movies

Operation Display Screen

1. Touch   to go to the Delete option screen.

2. Touch [Yes] to delete the current movie or [No] 
to cancel the operation and to exit; touch [All] to 
delete all movies.

3. Before all movies are about to be deleted, a 
confirmation screen will appear; touch [Yes] to 
execute the operation and [No] to cancel the 
operation.

 Note
•	 If a memory card has been inserted, you can only delete those movies stored on the card. 
•	 Movies on a written-protected memory card cannot be deleted.
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Picture Playback

Operation Display Screen

1. When in the Picture Playback mode, sweep to 
the right or touch  to go to the previous 
picture; sweep to the left or touch  to go to 
the next picture. 

2. While the picture is selected, press on the 
screen as well as go up to enter Magnification 
Mode.( The magnification Indicator appears on 
the screen) 

3. In the Magnification Mode, sweep to the top to 
zoom in or to the bottom to zoom out.

4. To navigate the magnified picture, press on 
the screen and move as well. (The inner 
Magnification Indicator turns red) 

5. Press OK Button or sweep to the bottom to exit 
the magnification mode.

6. Touch  /  to start or to stop the slide 
show.

7. Touch (  )to exit.

 Note
When	 the	 LCD	 is	 idle	 for	 a	 few	 seconds,	 the	 slideshow	 function	 icons	 will	 disappear	
automatically.
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Delete Picture

Operation Display Screen

1. Touch   to go to the Delete option screen.

2. Touch [Yes] to delete the current picture or [No] 
to cancel the operation and to exit; touch [All] to 
delete all pictures.

3. Before all pictures are deleted, a confirmation 
screen will appear; touch [Yes] to execute the 
operation and [No] to cancel the operation.

 Note
•	 If a memory card has been inserted, you can only delete those pictures stored on the card. 

•	 Pictures on a written-protected memory card cannot be deleted.
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Section 5 
Setting Your Camera 

Setting Menu

Operation Display Screen

1. Touch (on-screen icon) when in Record 
Mode. The Record menu wheel will show on the 
screen. 

2. Scroll and stop on [Setting]. The submenu of 
Setting pops up.

3. The Setting submenu contains 6 options for 
configuring your camera setup. They are Sound 
(operation sound), TV, Language, Time Setting, 
Format, and Default Setting.

4. Touch /  on the screen to change 
between the pages.

Sound

Enable or disable the keypad tone and the operation sound.

Operation Display Screen

1. In the Setting submenu, touch [Sound] to enter 
the option screen.

2. Touch the desired option. 

3. Touch [OK] to validate the setting.
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TV

Ensure that the appropriate TV standard of your area is selected – either NTSC or PAL.

Wrong TV system setting may cause image flickers.

• NTSC(60Hz): USA, Canada, Japan, South Korea and Taiwan, etc.

• PAL(50Hz): UK, Europe, China, Australia, Singapore and Hong Kong, etc.

Operation Display Screen

1. In the Setting submenu, touch [TV] to enter the 
option screen.

2. Touch the desired option. 

3. Touch [OK] to validate the setting.

Language

Use this option to select the language of the user interface. 

Operation Display Screen

1. In the Setting submenu, touch [Language] to 
enter the option screen.Touch /  on the 
screen to change between the pages.

2. Touch the desired option. 

3. Touch [OK] to validate the setting.
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Time Setting

Operation Display Screen

1. In the Setting submenu, touch [Time Setting] on 
the screen to go to the Time Setting menu. 

2. Touch Year, Month, Day, Hour, or Minute to set.

3. Adjust the numeric value by touching /  .

4. Touch [OK] to validate the settings. 

Format

Yes: Format the built-in memory ( When there is no SD card in the camera ) / SD Card (When there is 
an SD card in the camera). 

No: Do not format the built-in memory ( When there is no SD card in the camera ) / SD Card (When 
there is an SD card in the camera).

Operation Display Screen

1. In the Setting submenu, touch [Format] on the 
screen to go to the format confirmation screen

2. Touch [Yes] to execute the operation and [No] to 
cancel the operation.

 Note
All	the	data	will	be	erased	if	the	SD	card	is	formatted.	Make	sure	all	the	data	are	copied	to	your	
PC before formatting the SD card.
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Default Setting

To restore the default factory setting, select this option. 

Operation Display Screen

1. In the Setting submenu, touch [Default Setting] 
on the screen to go to the Default Setting 
confirmation screen.

2. Touch [Yes] to execute the operation and [No] to 
cancel the operation.

  

The following table indicates the camera’s default settings 

Setting Default Factory Setting

Resolution FHD (1080p 30) for Movie

Std (5MP) for Picture

Scene Auto

Stabilization Off

Macro Mode Auto

Motion Detection Off

Slow Motion Off

Time Lapse Off

White Balance Auto

Self Timer Off

ISO Auto

Sound On

TV Depends on shipping area

Language Depends on shipping area

Volume Level 6
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Section 6 
 Viewing Pictures and Movies on TV

Connecting to a High-Definition 16:9(Wide) TV

1. Connect the HDMI cable to your camera’s HDMI Out port.
2. Connect the other end of the cable to a television.
3. Set the video input source of your TV to “ HDMI.”

(16:9)

4. Use the buttons to view the stored pictures and movies on the TV. 

Operation On TV

1. Press OK Button to play movies and press it again to 
pause. 

2. While playing movies, press Right/Left Buttons to fast 
forward/rewind and then release the button to stop.

3. Use Up/Down Buttons to adjust the volume.
4. In the Picture Playback mode, use Tele Button to magnify 

the picture. To navigate the magnified picture, use 
Direction Buttons to navigate the magnified picture. Press 
OK Button to exit the magnification mode.

Note
The	LCD	Panel	does	not	display	when	the	camera	is	connected	to	an	HDTV.

Connecting to a non-high-definition 4:3 TV

1. Connect one end of the AV cable to your camera’s AV out port.

2. Connect the other end of the cable to a television.

3. Use direction button to view stored pictures and movie on a TV. 

( 4 : 3 )

 Note
The	LCD	Panel	does	not	display	when	the	camera	is	connected	to	a	TV.
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Section 7 
Using the Software

Installing the Software

You must be connected to the internet to install and run the Vivitar Experience Image Manager software.

1. Insert the installation CD into your CD-ROM drive. The installation screen should automatically open. 

 

2. On PC: The Vivitar Experience Image Manager Installer window appears. If the window does not 
appear, open the application’s CD/DVD drive and click on “Setup.exe” to launch the installer.

3. On Macintosh: Click the icon that appears on the desktop to install the Vivitar Experience Image 
Manager.

4. If you do not have internet access at the time of inserting the CD-ROM, connect to the internet and 
then click the “Install Vivitar Experience Image Manager” button to begin the installation. 

 Note
•	 If you do not have internet access, you can still download media from the camera. Click the 

“How to transfer photos and videos from my camera to my computer” button for instructions.

5. If you have internet access, the “Choose your language” window opens, choose your language 
and click “Next” to open the next window.

6. Select your camera model from the list and click “Next” to open the next window.

7. Click “Next” to confirm your camera model selection and to install the application.

8. Please wait while the application is being installed on your computer.                    

9. Please review the license terms. 
On PC and Macintosh: Click the “I accept the terms of this license agreement” and then click 
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“Next” to continue.

10. On PC only: Let the “Vivitar Experience Image Manager” installer create the folder to where the 
program will be installed, and then click “Install”. 

11. Please wait while the application continues the installation process on your computer.

12. On PC: Click the “Close” button when the installation is complete.  
Click the “Launch Vivitar Experience Image Manager” to open the application.

13. On Macintosh: Click the “Quit” button when the installation is complete. 
Click the “Launch Vivitar Experience Image Manager” to open the application.

14. If you close the application you can run the Vivitar Experience Image Manager from the Programs 
(PC) or Applications (Mac) menu on your computer.  

Connecting the Camera to a Computer

1. Use the USB cable that came with your camera to connect your camera to your computer.

2. Power the camera ON.

3. The first time you connect the device to the computer you will have to wait a few seconds until the 
computer recognizes the device.

Getting Photos and Videos from your Camera to your Computer

Do not disconnect the cable during transfer. Doing so will cancel the transfer of any files on their way to 
your computer.

1. Select the “Get Images” button from the Main menu.



34
EN

2. The “Get Images from device” window opens.

3. You can select to download photos, videos or both.

4. Select your camera (removable disk) from the device window. If your camera is the only USB device 
connected then it will be selected automatically.

5. Select a location on the computer where to place the new photo and video files.

6. Add the new photo and video files to albums if desired.

7. Select to remove the media files from the selected device (removable disk) after the import.

8. Click the “Get Images” button to transfer the photos and videos from your camera to your computer.

9. A media download progress bar appears on the bottom left showing the number of media files 
downloading to your computer. A message appears when the download is complete.

10. The photo and video files that you selected are now downloaded to your computer to the selected 
folder and albums ready for your use.

Get Started!

Using the Vivitar Experience Image Manager, you can:

• Upload and manage photos and videos to and from the most popular photo sharing and social 
networking sites - Facebook, Flickr, Picasa, MySpace, Photobucket, Twitpic, Twitgoo and YouTube 

• Seamlessly transfer photos and videos from one social network to another

• Organize your images by creating offline and online albums 

• Edit images using automatic and manual tools 

• Use automatic “Geotagging” with built in Google Maps

For more details on how to use the Vivitar Experience Image Manager open the Help file or click the 
“Take the Tour” button on the application`s Home page.
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Section 8 
 Transferring Media

Transfer media: Using Windows

To transfer media from your camera to your computer manually using Windows:

1. Use the USB cable that came with your camera to connect your camera to your computer.

2. MSDC appears on the LCD.

3. A window appears with a list of options, select “Open folder to view files” and click OK.

4. Open the DCIM folder and the folder inside to view the media files.

5. Select the media and copy the files from this folder into your computer. Optionally, select the files 
and choose Copy from the Edit menu. Then select a folder and choose Paste from the Edit menu. 

6. It is recommended that you copy the images into the Pictures/My Pictures folder and the videos into 
the Videos/My Videos folder.

7. Do not disconnect the cable during transfer. Doing so will cancel the transfer of any files on their 
way to your computer.

Transfer media: Using Macintosh

To transfer media from your camera to your computer manually using Macintosh:

1. Use the USB cable that came with your camera to connect your camera to your computer. 

2. MSDC appears on the LCD.

3. he camera’s device icon appears on the desktop.

4. Click on the device icon and open the DCIM folder and the folder inside to view the media files.

5. Select the files and drag them into your computer. Optionally, select the files and choose Copy from 
the Finder’s Edit menu. Then select a folder and choose Paste from the Edit menu.

6. We recommend that you copy the images into the Pictures folder and the videos into the Movies 
folder.

7. Do not disconnect the cable during transfer. Doing so will cancel the transfer of any files on their 
way to your computer.
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Section 9 
 Sakar  Warranty Card

This warranty covers for the original consumer purchaser only and is not transferable. Products that 
fail to function properly UNDER NORMAL USAGE, due to defects in material or workmanship will be 
repaired at no charge for parts or labor for a period of one year from the time of purchase.

What Is Not Covered By Warranty:

Damages or malfunctions not resulting from defects in material or workmanship and damages or 
malfunctions from other than normal use, including but limited to, repair by unauthorized parties, 
tampering, modification or accident.

What to Do When Service Is Required:

When returning your defective product (postage pre-paid) for service, your package should include:

1) Copy of original bill of sale

2) A detailed written description of the problem.

3) Your return address and telephone number (Daytime)

MAIL TO ADDRESS BELOW:

Sakar US Sakar UK/Europe Sakar Australia
Sakar International

Attention: Service Department

195 Carter Drive

Edison, NJ 

08817

Attention: Service Department

2D, Siskin Parkway East

4020 Middlemarch Business Park

Coventry, CV3 4PE

Return faulty camera to the 
Refund Counter at the store 
where purchased

Section 10 
 Technical Support

For technical support issues please visit our website at www.vivitar.com. You can find manuals, 
software and FAQ’s at the website. Can’t find what you are looking for? E-mail us at support@vivitar.
com and one of our technical support team members will answer your questions. For phone support 
in the US please call 1-800-592-9541, in the UK call 0800 917 4831, in Australia call 1800-006-614.  If 
you would like to call from anywhere else, please visit www.vivitar.com for your local toll free number.
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Section 11 
 Specifications and System Requirements

Specification

Image sensor 5 Mega pixel CMOS sensor

Operation modes Movie record, Picture record

Lens f=5.95~59.5mm F2.0~2.8

Focus range Macro mode: wide:1cm~Infinite, tele:60cm~Infinite

Auto mode: wide:10 cm~Infinite, tele:100 cm~Infinite

Zoom FHD (1080p 30):1X~10X (10X Optical zoom and 1X Digital zoom)

Other video resolution:1X~40X (10X Optical zoom and 4X Digital 
zoom)

Shutter Electronic

LCD monitor 3” touch LCD  

Storage media Built-in 128MB memory (partial memory is used for firmware code);

SD/SDHC card slot support (up to 32GB)

Image resolution High: 4608x3456 (16M pixels)

Standard: 2592x1944 (5M pixels) 

Low: 2048x1536 (3M pixels)

Movie resolution FHD (1080p 30) 1920X1080(30fps)

HD (720p 30) 1280X720(30fps)

WVGA60 848X480(60fps)

VGA (4:3) 640X480(30fps)

White balance Auto/Manual (Daylight, Fluorescent, Tungsten)

ISO Auto/800/1600

Self-timer 10 seconds delay

Flash Flash Auto/Red-Eye-Reduction/Digital Light/Flash Off

File format Picture: JPG

Movie: AVI

Image play Single image/Slideshow

PC interface Mini USB 2.0 port

TV out NTSC/PAL selectable, HDMI

Battery Lithium-ion rechargeable battery

Dimension 67.5(H) * 62.3(W) * 122(L) mm

Weight 270 g (without battery)
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System requirements

• Microsoft Windows XP/Vista/7

• Intel Pentium 4, 2.4GHz or above

• 512 MB RAM

• CD-ROM Drive

• 1 GB free HDD space

• Available USB port

• 16-bit Color Display

 Note
The LCD screen is manufactured using extremely high-precision technology, so over 99.99% of

the	pixels	are	operational	for	effective	use.	However,	some	tiny	black	and/or	bright	dots	(white,	
red, blue or green) may appear on the LCD screen. These dots are a normal result of the 
manufacturing process, and do not affect the recording.
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Section 12 
 Troubleshooting

Troubleshooting 

1. If the LCD preview is not clear while shooting, how can the focus be adjusted?

Try to switch between Macro and Auto Mode.

2. The flash is not working.

The battery power is low.

The camera is in DC  power mode.

3. The files on the memory card do not display smoothly when the LCD shows the “!” marking.

The “!” means the SD card is low speed or is having wrong content inside. The way to solve this 
condition is to format SD card by the camera instead of a PC (Please refer to the detailed Format 
instruction in Section 5). 

4. Why is camera flash not active when taking pictures?

In the flash auto mode, the camera flash fires ONLY when necessary (e.g. in the dark).

5. Why do some of my indoor pictures look blurry and dark?

The camera extends picture exposure time under low light/ indoor condition. Keep the camera (and

the target subject) steady for several seconds when taking pictures. The shutter will sound when 
pictures are being taken.

6. How do I charge battery?

You must use the supplied AC charger or the USB cable.

The camera must be turned OFF; blinking light confirms charging, and the light becomes constant 
when the charging has been completed. Then, the light will turn itself off automatically after 5 minutes.
(In AC charging Mode).

7. I have taken photos and selected the “Get Images” button. I get a message that the images 
were successfully transferred but the photos do not appear on my computer.  What do I 
do?
First ensure that you have in fact taken photos. Press the Shutter button to take some sample 
photos and then try downloading them again. 
With test photos if the camera powers off before you upload them to the computer the photos are 
not stored in the camera`s memory. These photos should be uploaded quickly before the camera 
powers off.  If the photos are saved to the SD memory card then all the photos should appear.

 

8. How do I make sure I don't lose important pictures?
We recommend always downloading your photos to your computer as soon as possible to prevent 
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unintentional data loss.    

9. I deleted images using the Vivitar Experience Image Manager. The images were also 
deleted from my computer. How do I recover images that I accidently deleted? 
All images deleted using the Vivitar Experience Image Manager are sent to your computer`s 
Recycle or Trash Bin and can be retrieved from there.


